
When I’m at work: 
Using a computer
Learner’s workbook



When I’m at work: Using a computer | Learner’s workbookii

Contact details

Branch Disability Program Branch

Department Australian Government Department 
 of Families, Housing, Community Services and  
 Indigenous Affairs

Postal address GPO Box 9820 BRISBANE QLD 4001

Phone 1300 653 227 Toll Free

Website www.fahcsia.gov.au

Acknowledgement

This resource was produced by Wodonga TAFE in association with Aware 
Industries with funding from the Australian Government Department of Families, 
Housing, Community Services and Indigenous Affairs.

Copyright

© Commonwealth of Australia [2008]

This work is copyright. You may download, display, print and reproduce this 
material in unaltered form only (retaining this notice) for your personal, non-
commercial use or use within your organisation. Apart from any use as permitted 
under the Copyright Act 1968, all other rights are reserved.

Requests for further authorisation should be directed to the Commonwealth 
Copyright Administration, Attorney-General’s Department, Robert Garran Offices, 
National Circuit, Canberra ACT 2600 or posted at http://www.ag.gov.au/cca

FaHCSIA1049.0804



When I’m at work: Using a computer | Learner’s workbook iii

Contents

Introduction ................................................................................................... 1

Getting started ...............................................................................................3

The equipment ................................................................................................4

Using a computer ............................................................................................9

1 Input devices .............................................................................................11

2 Processing devices .................................................................................... 12

3 Output devices .......................................................................................... 12

What is a computer system? ........................................................................... 13

What is hardware and software? .................................................................... 15

Using a keyboard ........................................................................................... 17

Using a mouse ............................................................................................... 19

Getting started ...............................................................................................22

Using Microsoft Word® ................................................................................29

Microsoft Word® ...........................................................................................30

Opening Microsoft Word® ............................................................................. 31

Saving documents .........................................................................................32

Closing documents ........................................................................................34

Opening an existing document ...................................................................... 35

Printing a document ......................................................................................36

Sending and receiving email .........................................................................39

What is email? ...............................................................................................40

What is the Internet? ......................................................................................40

Email addresses ............................................................................................ 41

Opening Microsoft Outlook® .........................................................................42

Reading your emails.......................................................................................44

Replying to an email ......................................................................................45

Deleting an email ...........................................................................................46

Creating a new email......................................................................................47

Attaching files ................................................................................................48



When I’m at work: Using a computer | Learner’s workbookiv



When I’m at work: Using a computer | Learner’s workbook 1

Introduction
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Welcome to this learner’s workbook for supported employees in a Disability 
Business Service.

This learner’s workbook will guide you through the following topics:

◗ using a computer, including hardware and software

◗ producing a word-processed document

◗ sending and receiving emails.

At the end of each topic is a checklist of the areas covered in the topic.

Ask your trainer to sign each page as a record that you have successfully 
completed the training.

The images and examples in this workbook are from Microsoft Word® 2003 and 
Microsoft Outlook® 2003.
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Getting started
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The equipment

A typical computer workstation looks something like the picture below.

3. Keyboard 4. Mouse

1. Processor (computer) 2. Monitor (or screen)

5. Printer
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ACtIvIty: Your workstation

Identify each of these items at your workstation.

1 Monitor (may also be called a ‘screen’) ............................................................................................................

2 Keyboard  ............................................................................................................................................................................................

3 Mouse  ...................................................................................................................................................................................................

4 Computer  ...........................................................................................................................................................................................

5 Printer  ....................................................................................................................................................................................................

Before you start any work with computers you must ensure that you follow safe work 
practices. You must be comfortable when working at a computer and must always 
tell your supervisor if you feel you are in any pain or are feeling uncomfortable.

Not only for your comfort, but Australian law states that you have to be safe at 
work. Ergonomic requirements means how you use the computer equipment  to 
ensure you are comfortable and safe whilst working.

Ergonomic is a term used to describe furniture and equipment that has been 
designed for comfort, efficiency and safety especially in the workplace.

Following is a list of areas around your workstation that you need to pay particular 
attention to.
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◗ The height and layout of your workstation

This is vital for you to be able to do your work well. Your feet should be on the 
ground and your hands should be resting on the keyboard.

◗ Chair height, seat and back adjustment

These should be checked and adjusted on a daily basis as some other person 
may sit at your chair and change the adjustments without you being aware.

◗ Monitor (or screen) position

You should not be looking up or down at your monitor (or screen), but it should be 
directly in front of you at eye level or slightly lower.

◗ Keyboard and mouse position

These should be placed to best suit you. The keyboard should be in front of you. 
The mouse should be on your right if you use your right hand or on your left if you  
mainly use your left hand.

◗ Lighting

Lighting should be strong and not cause any glare.

◗ Checking your workstation

Source: Stephens, A & Symons, J 2002, Develop and use spreadsheets, Tertiary Press, Victoria.
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◗ Regular breaks

Try to get up for a few minutes every hour when using the computer. You may like 
to walk around or do some exercises to relieve any muscle strain. Some examples 
of stretching exercises are below.

Neck

Drop your head slowly first to 
the left, then to the right. Drop 
your chin to your chest, then 
raise it, letting your head drop 
back. Turn your head to the 
left, then to the right. Repeat 
two or three times.

Shoulders

With your elbows at your sides 
slowly roll your shoulders 
forward three or four times. 
Then roll them backwards 
three or four times.

Arms

Raise your arms 
straight out to the 
sides at shoulder level. 
Rotate your arms forward 
in small circles three or 
four times. Then rotate 
them backwards three or 
four times.

Upper arms

Clasp your hands behind 
your back, locking your 
elbows. Raise your arms 
high, then let them drop. 
Repeat three or four times.

Wrists

Place your forearms and 
wrists flat on the desk. 
Keeping your wrists on the 
table, bend your hands and 
fingers back. 
Repeat three or 
four times.

Fingers

Place your hands palm 
down and spread your 
fingers into a fan. Count 
to five, then relax. Repeat 
three or four times.
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Topic checklist
Tick the areas from this topic that you have successfully completed.

Name: __________________________________________________________ 
has successfully completed the topic Getting started from the When I’m at 
work: Using a computer training program.

Areas covered included:

◗ Equipment  q

◗ Set up   q

◗ Regular breaks  q

Trainer: __________________________________________________________

Date: ____________________________________________________________
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Using a computer



When I’m at work: Using a computer | Learner’s workbook10

A computer changes or processes information into a form that is easier to use 
and understand. Processing means changing the information which you enter 
into the computer into something you can use.

1. Information into

the computer

2. Information processed

by the computer

3. Information in a form

you can use

1. Input

2. Process 
information

3. Output
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Mouse

Digital camera

Keyboard

Microphone

Scanner

1 Input devices

Input devices are tools or pieces of equipment to help you put information or 
data into a computer.
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2 Processing devices

Processing devices are the ‘brains’ of a computer system. 
They are often called CPUs, which stands for Central 
Processing Units, and they are stored in metal boxes (like the 
picture). The button to turn on your computer is located on the 
CPU.

3 Output devices

Output devices are tools or equipment that help you to see and use the 
processed information.

Printer

Monitor (or screen)

Speakers

Modem
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What is a computer system?

A computer system has the parts that make your computer work. A basic system 
will include:

1 central processing unit (CPU) – this processes information and sends 
messages to all other areas of the computer system

2 monitor – this is the screen that you use to look at your information

3 keyboard – consists of a number of keys with letters, numbers and different 
symbols on them. You enter information into your computer system by 
selecting and touching the keys

4 mouse – this is the pointer that you can use as well as your keyboard to tell 
your computer what you want it to do

5 printer – this is used to print out the information that you put into the 
computer and has been processed by the computer. This could be copies of 
letters, reports and messages you have received by email, or information you 
have looked at on the internet that you would like a copy of.

You may add other types of equipment to your computer system so that it can do 
extra things. These could include digital cameras, microphones or scanners.

3. Keyboard 4. Mouse

1. Processor (computer)2. Monitor

5. Printer
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Information into
the computer

Information processed
by the computer

Information in a form
you can use

1 Input devices are the parts of 
the computer that help you put 
information into the computer. 
They include:

◗ keyboard

◗ mouse

◗ camera

◗ microphone

◗ scanner.

2 Processing devices are the 
parts of the computer where 
the information is processed or 
changed and include:

◗ CPU (computer).

3 Output devices are those parts 
of the computer that put the 
information into a form that you 
can use, and include:

◗ printer

◗ monitor (or screen)

◗ speakers

◗ modem.
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What is hardware and software?

There are two parts of a computer system that are needed so your computer will 
work – they are called hardware and software.

Hardware

Hardware is anything that you can touch.

Examples of hardware could be the:

1. Printer

2. Screen

3. Keyboard

4. Mouse

5. Scanner
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ACtIvIty: Your hardware

Can you touch all of your pieces of hardware for your computer?

1 Printer  ....................................................................................................................................................................................................

2 Screen (or monitor)  ................................................................................................................................................................

3 Keyboard  ............................................................................................................................................................................................

4 Mouse  ...................................................................................................................................................................................................

5 Scanner  ...............................................................................................................................................................................................

Software

Software is what is inside your computer that allows you use it to do different 
tasks. Software makes your computer work so you can see everything on the 
screen. A computer cannot work without software.

Some of the software packages that you might use include:

type of software What it does

Microsoft Word® Allows you to type up a document, 
such as a letter.

Microsoft Excel® Allows you to type in figures, use 
formulas and create charts.

Microsoft PowerPoint® Allows you to create presentations for 
meetings, etc.
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Using a keyboard

There are 104 keys on a keyboard. Most are letters and numbers but others 
help you to move around the screen. Some keys you will use a lot, and there are 
others that you will use less often, or might never use at all. A list of the keys you 
are likely to use, with an explanation of what they do, is included below.

Enter

You use your right hand little finger to press it. Press 
ENTER only when you want to start a new paragraph, or 
to go to the next line.

Home

This key is used when you want to go back to the 
beginning of the line you are working on.

End

This key will take you to the end of the line you are 
working on.

Cursor

The four arrows in a group under the 
HOME and END keys are the CURSOR 
KEYS. Using these will move your 
cursor ‘ | ’ on the screen one letter or 
number at a time in the direction of 
the arrow.

Shift

There are two SHIFT keys, one on the left and one on 
the right of the main keyboard. Using these will make a 
letter appear as a capital. This is also known as upper 
case. The SHIFT key is also used if you want to type any 
of the symbols at the top of each number, for example, 
if you hold down the SHIFT key and at the same time 
type ‘5’ the ‘%’ symbol will appear.

Caps lock

The CAPS LOCK key is found on the left of the keyboard. 
If this is pressed once, all letters will appear as capitals, 
or upper case. You can do this with the SHIFT key as 
well. It is better to use this key if you want to type more 
than one capital letter in a row. Press this once more to 
turn it off.

Enter

Home

End

Shift

Caps Lock
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Delete

This will delete information to the right of the cursor.

Backspace key

This key is allows you to move back to information 
you have already typed in. It lets you erase letters or 
numbers to the left of the cursor.

Page up

This key lets you move up a page at a time.

Page down

This key lets you move down a page at a time.

ACtIvIty: Using the keyboard

Can you find the following keys on your keyboard?

1 Enter  .......................................................................................................................................................................................................

2 Home  .....................................................................................................................................................................................................

3 Backspace  ........................................................................................................................................................................................

4 Shift  .........................................................................................................................................................................................................

5 Page Up  ...............................................................................................................................................................................................

6 Page Down  .......................................................................................................................................................................................

7 End  ...........................................................................................................................................................................................................

Backspace

Delete

Page
Up

Page
Down
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Using a mouse

Parts of the mouse

The mouse has a right and left button. It may also have a wheel button in the 
middle. By rolling your finger over the centre wheel you can move (this is called 
scroll) up and down pages and you can also use the wheel to zoom in on certain 
things on the page in some software packages.

You can use a mouse pad or mouse mat 
with your mouse for easier use. A mouse 
pad can be any hard surface area but one 
that is built for a computer system usually 
works a lot better.

Wheel between the right 
and left mouse buttons 

– used to move/scroll up 
and down pages

Left mouse button – 
click to move the 

pointer to any position 
on the screen

Right mouse button – 
click to bring up 

other menus
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Terms

There are quite a few words that you will need to learn that explain what to do 
with your mouse buttons. You use the mouse buttons to tell your computer what 
to do. These are called commands.

Left mouse button command How to do it

Point Move the mouse to make the pointer or 
arrow move on the screen.

Click When the pointer is where you want it click 
the left mouse button and release.

Click and drag This lets you move things around the screen.

1   Move the pointer to where you want it.

2   Click the left mouse button. Keep your 
finger on the button.

3   Move or drag the pointer to a different 
part of the screen.

Double click Click the left mouse button twice very 
quickly. This takes practise to get it right. 
Once you do, you will be able to tell the 
computer what to do more easily.

Right mouse button command How to do it

Click When you have the 
pointer where you want 
it on the screen, click 
the right mouse button 
and take your finger off 
the button. A menu box 
like the one shown here 
will be on the screen 
so you can choose 
different things. 
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tips for using the mouse

✓ Don’t hold the mouse tightly. It is easier to control the mouse if you hold it 
gently.

✓ There is no need to take your hand off the mouse between movements.

✓ Don’t lift the mouse up.

ACtIvIty: Now you try handling a mouse
1 Look at the picture of the hand holding a mouse, and try to copy it.

2 Put your right hand on the mouse gently, making sure that your index 
(pointing) finger is on the left mouse button. Most of the mouse should sit 
under the palm of your hand.

3 By holding the mouse and moving it around the mouse pad (or your desk if 
you don’t have a mouse pad) you will see that the pointer will move around 
the screen.
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Getting started

Ask your trainer or supervisor to demonstrate how to turn the computer on. In 
some workplaces workers need ‘log-ins’ and ‘passwords’ to access the computer.

One of the best ways to get used to using a mouse is to practise. To do this you 
will need to turn your computer on so that it shows the desktop screen.

Start button

Toolbar
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ACtIvIty: Let’s practise

Dragging

Dragging means to move something on the screen.

Try dragging on the Recycle Bin symbol    (also called an icon) on your 
screen and move it to the right hand side of the screen.

1 Point your mouse at the icon.

2 Then hold the left hand mouse button down.

3 Move the mouse across your mouse pad. Notice how the icon moves across 
the screen at the same time.

Now try dragging other icons to move them where you like on the screen.

Double clicking

This means clicking the left mouse button twice (very quickly).

With your mouse point to the Recycle Bin and double click. This will open the 
Recycle Bin program.

Closing programs

In the top right hand side of the screen there are three buttons. Click    with 
the left side of your mouse once. This will close the Recycle Bin.

Close button
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ACtIvIty: Using the calculator

Click on the Start button  . The Start button lets you open the programs 
on your computer.

Move your mouse pointer over the words All Programs. A list of programs will 
appear to the right.

1 Move your mouse 
pointer over the 
word Accessories. 
Another list of 
programs will 
appear to the 
right. Find the 
Calculator.

2 Move your mouse pointer over 
the word Calculator and with 
the left side of your mouse click 
once. You should have a picture 
of the calculator on the screen.

3 Click the left side of your mouse 
on the following buttons on the 
screen:

5 + 8 + 3 + 2 + 1 =

4 Did you get 19 to appear as the 
answer in the white box at the 
top?

5 Now try these calculations:

5 * 5 * 2 =

10 + 6 + 10 + 4 – 20 =

50 / 5
Note that on the calculator the symbol * is the same as X or multiplication, and 
the symbol / is the same as divide.
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ACtIvIty: Mouse talk

Now we are going to check that you understand what has been covered so far 
in this section. Read the terms and descriptions below. After you find the right 
description that matches each term draw an arrow between them.

You can check your answers against the ones listed on the next page.

Double click

Click the left mouse 
button and drag the 
pointer to a diferent 
part of the screen.

Left mouse 
button

Lightly click the left 
mouse button 

and let go.

Click

The symbol, usually an 
arrow, that appears on 
the screen when you 

move the mouse.

Right mouse 
button

The button that you 
use to control 

what you select.

Click and drag

When you click this, 
a menu or list will 

appear that you can 
choose from.

Pointer
Click the left mouse 

button two times 
quickly.
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Answer

Double click

Click the left mouse 
button and drag the 
pointer to a different 

part of the screen.

Left mouse 
button

Lightly click the left 
mouse button 

and let go.

Click

The symbol, usually an 
arrow, that appears on 
the screen when you 

move the mouse.

Right mouse 
button

The button that you 
use to control 

what you select.

Click and drag

When you click this, 
a menu or list will 

appear that you can 
choose from.

Pointer
Click the left mouse 

button two times 
quickly.
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Topic checklist
Tick the areas from this topic that you have successfully completed.

Name: __________________________________________________________ 
has successfully completed the topic Using a computer from the When I’m at 
work: Using a computer training program.

Areas covered included:

◗ Input devices   q

◗ Processing devices  q

◗ Output devices   q

◗ What is a computer system? q

◗ What is hardware and software? q

◗ Using a keyboard   q

◗ Using a mouse   q

◗ Getting started   q

Trainer: __________________________________________________________

Date: ____________________________________________________________



Notes
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Using Microsoft Word®
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Microsoft Word®

Microsoft Word® lets you type letters, minutes of meetings, a resume for a job, 
reports and other kinds of documents. Although there are a number of versions 
of Microsoft Word®, we will be using Microsoft Word® 2003 in this resource. 
Microsoft Word® is also known as ‘Word’.
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Opening Microsoft Word®

Click on the Start button  .

1 Point to All Programs and move your mouse to the right.

2 Move your mouse down the list of programs and click on Microsoft Word®.

3 Word will now start.

Below is a new Microsoft Word® document. You can type in the white area. You 
should notice that there is a blinking key that looks like ‘ | ’. Remember that this 
is called the cursor.

This is where you will begin to type. It is usually after the last thing that you type 
in, but if it is a new document it will be at the very top of the page.

Type your information here and the words you type appear on the screen.

Before you type in your information look at the screen in front of you or at the 
image on the page above. The areas at the top of the screen or image are called 
the Menus and Toolbar. From the menus and toolbar you can choose menu items  
to help you when you are putting information into the computer. Your supervisor 
or trainer will show you some of the menu items and ‘tools’ you can use.

ACtIvIty: Typing in Microsoft Word®

Type your name and the name of your Disability Business Service.

Menus

Cursor

Toolbar
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Saving documents

Saving documents on your computer means that you will be able to use the 
documents again.

ACtIvIty: Saving your Microsoft Word® document

With the document you created previously on the screen in front of you:

1 Click on the File menu.

2 Click on Save As from the menu 
box. A ‘dialog box’ opens on the 
screen. A dialog box appears on 
the screen to give you choices 
about what you would like the 
computer to do.

3 Type in Practice 1 in the File 
name box. On the computer each 
document you make and save is 
called a file. You can put many 
files into a place called a folder in 
the computer.

4 Your supervisor or trainer will tell 
you how to fill in the information 
in the dialog box so that your 
information is saved for later.

File name

Folders and files 
saved on your 

computer

Save button

Save As 
in the File menu
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5 Click on the Save button    in the dialog box, and Microsoft 
Word® will save the document as a file called Practice 1. This will also change 
the name at the top of your document.

tips when saving

✓ Try to save your document as soon as you can so you don’t lose it if there 
is a power failure.

✓ Give the document a name that tells you what it is about.

✓ Choose a location to save it to where you can easily find it again.

✓ Talk to your trainer or supervisor about where you can save documents to.

File name
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Closing documents

Once you have saved your document you can close it.

To close your document:

1 Click on the File menu.

2 Choose Close.

Please note: If you have not saved 
your document a dialog box will 
pop up and ask if you want to save 
the document. If you click Yes the 
Save As dialog box will appear on 
the screen. If you click on No, the 
information you typed will not be 
saved.

ACtIvIty: Closing your document

Close the file Practice 1 by clicking on the File menu and moving the mouse to 
Close, and then click.

Close 
in the File menu
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Opening, changing and saving changes to an 
existing document

To open an existing document:

1 Click on the File menu.

2 Choose Open to get you to a 
dialog box.

3 Click on the file name that you want and then click on the Open button.

4 Type your changes, for example, add the address of your workplace.

5 Click on the File menu and you can save the document so it is ready for the 
next time you want to use it.

ACtIvIty: Opening your document

Open the file Practice 1 by following the above steps 1 to 3.

Open 
in the File menu

File name

Folders and files 
saved on your 

computer

Open button
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Printing a document

If the computer you are using is connected to a printer then you can print your 
document.

To print your document:

1 Click on the File menu.

2 Choose Print from the menu.

3 A Print dialog box will appear on 
the screen.

4 Move the mouse and click OK.

5 Your document is now printing.

ACtIvIty: Printing your document

Print the file Practice 1 by following the above steps 1 to 5.

Print 
in the File menu

Printer your 
document will 

print to

OK to print button
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Topic checklist
Tick the areas from this topic that you have successfully completed.

Name: __________________________________________________________ 
has successfully completed the topic Using Microsoft Word® from the When 
I’m at work: Using a computer training program.

Areas covered included:

◗ Opening Microsoft Word®  q

◗ Saving documents   q

◗ Closing documents  q

◗ Open an existing document q

◗ Printing a document  q

Trainer: __________________________________________________________

Date: ____________________________________________________________



Notes
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Sending and receiving email
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What is email?

Email stands for electronic mail and you can use email to:

◗ send messages to another person or a group of people

◗ receive messages from people

◗ attach documents, pictures or sounds to messages.

What is the Internet?

The Internet is a network of computers all over the world that allows you to 
access, download and send information through your computer.

The Internet is avilable 24 hours a day and the things you can do on the Internet 
include:

◗ email, using platforms such as Hotmail

◗ research information, using search engines such as Google or Yahoo

◗ online buying and selling, using places such as eBay or stores that are online

◗ online chatting, using facilities such as MSN or MySpace

◗ financial transactions, such as Internet banking

◗ access online libraries and encyclopaedias.

Email is one of the most used services on the Internet.



When I’m at work: Using a computer | Learner’s workbook �1

Email addresses

Every user needs their own individual email address.

Typical email addresses may look like:

allyson@bigpond.com.au

bwilliams@fahcsia.gov.au

User name This is the name or identity of the 
person sending the email

allyson bwilliams

@ At @ @

Domain name This is the organisation that gets paid 
for you to use emails

bigpond fahcsia

Organisation Indicates the type of organisation or 
group, for example: 

com – commercial organisation

net – local Internet service provider

edu – educational institution

gov – government body.

com gov

Country This is the country code, for example:

.au – Australia

.nz – New Zealand

.uk – United Kingdom

The only country that does not use 
a code is the United States. So their 
addresses end after .com

au au
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Opening Microsoft Outlook®

Open the email program used in your workplace.

Please note our example here is for Microsoft Outlook®.

1 Click on the Start button.

2 Choose email or Microsoft 
Outlook® from the menu.

3 Your emails will now be on screen.

Email features

The areas at the top of the screen are called the Menus and Toolbar. From the 
menus and toolbar you can choose menu items and ‘tools’ to tell the computer 
what you want it to do with an email. Your supervisor or trainer will show you 
some of the menu items and ‘tools’ you can use.

Inbox This is where you receive your emails

Outbox This is emails you are sending

Delete This is where you delete your messages after you don’t need 
them anymore – sometimes this is called the RecycleBin

Forward You can forward a message that you have received to 
another person

Attach Files Sometimes you want to send more than just a message.  
Attaching allows you to add files, images, sounds and 
videos to the message to send

Sent Items This is a list of emails you have sent.

Inbox

Start button

Email

Emails

Toolbar

Menus
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Inbox toolbar

Button Name Description

1   
New Create a new email

2   
Print Print this page

3   
Move to folder Move this email to a 

folder

4   
Delete Delete email and send 

to Recycle Bin

5   
Reply Reply to this email

6   
Reply all Reply to all people on 

this email

7   
Forward Forward this email to 

someone else

8   
Send/Receive Send/receive all emails 

in draft folder

9   
Find Find

10  
Rule Make a rule for email

11 Contact You can type the name 
of someone you have 
sent an email to before 
and their email address 
will be on the screen

12  
Help Access the Help Menu

1 2 3 4 5 6 7 8 9 10 11 12

Toolbar
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Reading your emails

The emails area shows the emails you have received. If the text is bold, this tells 
you that it is an email that you have not read yet.

1 Click on the Inbox. You will now see a list of all of the emails that you have received.

2 To read your emails click on each of the bolded entries one by one and read.

ACtIvIty: Reading your emails

Read the emails in your Inbox that are bold.

From – name of 
person who sent 

the email

Emails

Subject – what the 
message of the 
email is about

Received – time 
and date emails 

came to your Inbox
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Replying to an email

After you have read an email you can send a reply to the person who sent you the 
message.

To reply to an email:

1 With the email you received open, click on the Reply icon    from 
the toolbar. On the table on page 43 this is number 5.

2 On the screen will be an email with the address of the person you are sending 
the email to.

3 Type your message.

4 Click Send.

5 The email will no longer be on your screen.

allyson@bigpond.com.au

Send
Name and email address of the 

person you are sending the email to

Type your 
message here
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Deleting an email

When you have finished with an email you can delete it.

To delete an email:

1 Click on the Delete icon    on the toolbar. This was number 4 in our table 
on page 43.

2 Notice that the email is now gone from the list of emails in your Inbox.

ACtIvIty: Deleting your emails

Click on the email you wish to delete in your Inbox.

Click on the Delete key    on the toolbar.

Your email is now in the Deleted Items folder.
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Creating a new email

To create a new email message:

1 Open Microsoft Outlook®.

2 Click on the New button  . A blank message will be on your 
screen.

3 Type in the address of the person you are sending the email to.

4 Type in the subject of the email.

5 Type in your message.

6 Click on the Send button  .

ACtIvIty: Creating a new email

Create an email to your trainer or to another learner.

Type in a message and click send.

allyson@bigpond.com.au

Send
Name and email address of the 

person you are sending the email to

Creating a new email

Hi Allyson

Today we are learning to create new emails.

I am sending you a message as practice ...

Subject of 
your email

Type your 
message here
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Attaching files

Sometimes you might need to attach a document, picture, or another type of 
file to your email. For example, you might need to send your supervisor an email 
telling them about a safety problem in your work area and you might need to 
attach a file such as a report.

To attach a file to an email:

1 Open Microsoft Outlook®.

2 Create a new email. Remember to fill out the address and the subject.

3 Click on the Attach button  .

4 A dialog box will appear on your screen.

5 Ask your trainer to help you choose an attachment for your email.
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Topic checklist
Tick the areas from this topic that you have successfully completed.

Name: __________________________________________________________ 
has successfully completed the topic Sending and receiving email from the 
When I’m at work: Using a computer training program.

Areas covered included:

◗ What is email?   q

◗ What is the Internet?  q

◗ Email addresses   q

◗ Opening Microsoft Outlook® q

◗ Reading emails   q

◗ Replying to an email  q

◗ Deleting an email   q

◗ Creating a new email  q

◗ Attaching files   q

Trainer: __________________________________________________________

Date: ____________________________________________________________



Notes
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